
QUICK START GUIDE FOR CBECC-COM 2013 v3e
Version CBECC-Com 2013-v3e September, 2016

NOTE: Please check http://bees.archenergy.com/ for any updates to this guide.

Overview
CBECC-COM 2013 is an open-source software program developed by the California Energy Commission
for use in complying with the 2013 update to the Non-Residential Building Energy Efficiency Standards.
This Quick Start Guide for CBECC-COM 2013 was written to accompany versions of the software released
starting in June 2013.

This Quick Start Guide provides brief descriptions of the software program’s major features. It is a good
idea to review the Quick Start Guide before using the program for the first time or if you have questions
while using the program. Additional Help features will be added to future versions of the program.

Capabilities:
Calculate the annual energy use for both the Proposed Design and the 2013 Standard Design of non-
residential buildings. The feature set of CBECC-Com is listed at: http://bees.archenergy.com/

New in Version 3e:
Software & User Interface

• Upgrade of simulation engine to EnergyPlus 8.5.

• Expand support of partial compliance options for Additions.

• Added new input screens to define number of dwelling units and average floor area by
number of bedrooms.

• New feature enabling output of hourly EnergyPlus simulation results to CSV files during
analysis (via SimOutputVariablesToCSV*.ini file settings).

Envelope, Lighting & Other Internal Loads

• Added methodology for more accurate simulation of fenestration products with U-Factor >
1.03.

• Modified structure of inputs to allow specification of luminaires as new/altered/existing
within a single InteriorLightingSystem.

• Updated criteria for specification of prescriptive lighting power in Standard Design for
Alteration compliance types to exclude cases where < 10% of luminaires are affected by the
alteration.

HVAC

• Add the capability to identify load ranges for chilled water or hot water plant systems, and
then specify the chillers or boilers that are to be used in each load range.

• Add new HeatRecovery object, which can be added to AirSystems that are 100% outside air.

• Add support for modeling single-packaged vertical units (SPVAC and SPVHP) as new types
for AirSystem and ZoneSystem.

http://bees.archenergy.com/
http://bees.archenergy.com/
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• Add ability to specify fixed seating for nonresidential spaces.

• Added support for water coils for supplemental heating for Single Zone Heat Pumps

• For zones where there is no cooling, modified the baseline to also not have cooling.

• Added efficiency modifiers for zone systems that will not be tested for duct leakage and
meet the criteria in Section 140.4(l).

Service Hot Water /Domestic Hot Water Heating

• Upgraded simulation to use CSE (California Simulation Engine) for residential DHW.

Bugs Fixed in Version 3e:

• Corrected DHW internal calculations for High-rise Residential and Hotel/Motel Guest
Rooms.

• Revision to message for ThrmlZn:HVACZnCnt.

• Fixes to Opaque Envelope UA-value checks.

• Fixes to case where demising walls were not checked for mandatory U-factor compliance.

• Fixes to formatting of PostError message for pumps.

• Updates to EnergyPlus service hot water heating rules to better align with the Appliance
Efficiency Standards.

• Fix issue with baseline models not getting exhaust fan if proposed is 'Forced' mechanical
ventilation.

• Revise ThrmlZn:ExhAvailSchRef rule to ensure proposed exhaust fan schedule matches
HVAC availability if the exhaust system is used for ventilation. Also, fix rule so that standard
= proposed exhaust availability schedule if the exhaust is not used as ventilation system.
This issue is generally applicable to res spaces, where the ventilation system can be either
by primary system or exhaust.

• Update ThrmlZn:ExhFlowSchRef rule to ensure that baseline residential vent/exhaust
system flow schedule is always 'On'. Previously it would have matched the proposed
schedule if defined.

• Add warning to user when residential zone has 'Forced' ventilation from Primary Htg/Clg
System, but also has exhaust fan defined. In this case, it is assumed the exhaust is
intermittent exhaust, and therefore should not be modeled for compliance since it can't be
matched in the baseline.

• Add default FuncSchGrp for non-plenum HasNoInternalLds spaces.

• Changes to chiller rules that ignore user input COP values for electric chillers.

• Relaxed limitations on use of Center of Glass (COG) inputs for simulating fenestration
performance. New rules limit use of COG inputs to 1,000 ft² of new and/or altered site built
fenestration, but also allow additional site built fenestration using other performance
specification methods (i.e. CEC default and/or NFRC ratings) to be specified.

• Updated Window-to-Wall Ratio maximums to be calculated and enforced separately for
New Walls vs. Existing/Altered walls. Also modified window scaling rules such that
existing/altered glazing area is not reduced in the standard design model, regardless of area.

• Added user input for Fenestration Construction to indicate use of Dynamic Glazing, such as
electrochromic glass.

• Updated daylighting partial compliance rules to automatically install prescriptive daylighting
controls in the proposed model for ‘NewEnvelope’ and ‘NewEnvelopeAndMechanical’
compliance types.
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• Added lighting penalty to simplified geometry projects with proposed windows having a
Visible Transmittance less than the prescriptive minimum. This is intended to account for
reductions to daylighting potential associated reductions to Visible Transmittance.

• Added User input checkbox to the ‘Space’ dialog to indicate whether a space is part of an
Atrium greater than 55 ft. in height. When this box is checked, the maximum Skylight-to-
Roof ratio is increased from 5% to 10%.

• Exclude user-defined exhaust systems specified as ventilation systems from being simulated
in the Standard design.

• Correct TerminalUnit damper control for zones with CO2Sensor (DCV) controls.

• Add check to ensure AirSystems with only a heating coil is defined as Type = ‘HV’.

• Fixed bug to enable copy/paste of certain AirSys objects from within the UI’s component
tree.

• Fixed bug preventing valid geometry to be computed and used to simulate spaces with very
small floor areas (in simplified geometry models).

• Fixes to daylighting control positioning mechanism in spaces with unusual geometry (with
daylightable areas extending well beyond space boundaries).

• Fixed bug to ensure that reported TDV sums are consistent with individual enduses and the
compliance result.

New in Previous Versions:

• Upgrade of simulation engine to EnergyPlus 8.3.

• Add project-level selection of Gas Type (Natural Gas vs. Propane), and if propane, whether
or not natural gas is available onsite. Also related – replaced fossil fuel selections for various
HVAC & DHW equipment with a single “Gas” option, which maps to the new project-level
selection.

• Added ability to convert exterior, interior and underground wall surfaces to/from each
other, initiated via right mouse click menus in the building component tree.

• Established new file extensions for XML (.cibdx for 2013) project files.

• Added ability to generate a compliance report populated with data describing the Standard
Design model. This feature is available via the Project tabbed dialog as well as through the
application’s Tools menu.

• Added ability to simulate hot-water indirect fired, single-effect absorption chillers.

• Added ability to simulate waterside economizer heat exchangers.

• Revision of baseline multi-zone system supply fan sizing to be based on the ‘Coincident’
zone load.

• Addition of two new AirSystem control methods, ‘FixedDualSetpoint’ and
‘ScheduledDualSetpoint’. These allow discharge air temperature to float between two
limits, as opposed to controlling to a constant setpoint.

• Allow specifying priority HVAC equipment serving a thermal zone (if primary and ventilation
systems are different).

• Update of residential ventilation modeling methodology. Ventilation must now be modeled
as defined in the proposed design. If the proposed design uses forced (fan-driven)
ventilation, the baseline ventilation system is an exhaust fan system. If the proposed design
uses natural ventilation, the baseline ventilation is also natural.

• Add check and warning to notify users of E+ bug for primary pump control for
primary/secondary systems with more than one piece of primary equipment.

• Add support for cycling of AirSystems.
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• Enable Optimum Start control for all Air Systems (excluding Exhaust Systems).

• Added checks on mandatory duct insulation for all air systems.

• Added efficiency modifiers for air systems that meet the criteria in Section 140.4(l) that will
not be tested for duct leakage.

• Allow inclusion of water heaters in non-HVAC compliance paths through use of an
Exceptional Condition flag.

• Mixed use residential and nonresidential buildings now have separate baseline water
heating systems.

• Added input for number of dwelling units at each space to improve residential water
heating system calculations.

• Added a multiplier to SHW Fluid Systems that would typically be used for individual
residential units that have identical SHW Systems.

Known Issues:

• General Issues
o No resizing of baseline systems if unmet load hour (UMLH) requirement is not met.

• HVAC Secondary Systems
o Specifying DCV for all zones of a multi-zone system results in unexpectedly high

energy use.
o Simulation of supply air temperature and flow controls may not match ACM

requirements.

• HVAC Primary Systems
o All pumps on primary loop of primary/secondary pumping systems will run if there

is any demand on the secondary loop.
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Example Input Files: A series of example models are installed along with CBECC-Com in the Projects
directory. These models are of various building types and HVAC systems. The models with –CECStd in
the name are intended to represent minimally compliant buildings, they pass compliance with as small a
compliance model as possible, ideally zero.

Note: For the beta version of the software all the example models listed below may or may not be
included with the installation.

CEC Standard Tests
1. 010012-SchSml-CECStd
2. 020012-OffSml-CECStd
3. 020012S-OffSml-CECStd
4. 030012-OffMed-CECStd
5. 030012S-OffMed-CECStd
6. 040012-OffLrg-CECStd
7. 050012-RetlMed-CECStd
8. 060012-RstntSml-CECStd
9. 070012-HotSml-CECStd
10. 080012-Whse-CECStd
11. 090012-RetlLrg-CECStd

Other Tests
1. 010112-SchSml-PSZ
2. 010212-SchSml-PVAVAirZnSys
3. 010312-SchSml-VAVFluidZnSys
4. 040112-OffLrg-AbsorptionChiller
5. 040112-OffLrg-VAVPriSec
6. 040112-OffLrg-Waterside Economizer
7. 050112-RetlMed-SZVAV
8. 050312-RetlMed-Alterations
9. OffLrg-PlenumsFPBsData
10. OffLrg-PrkgExhaust
11. OffLrg-PrkgLab
12. OffLrg-PrkgLabKitchen
13. OffSml-CombDHWSpcHt
14. OffSml-CommKit_SZVAV
15. OffSml-Data_SZVAV
16. OffSml-HtRcvry
17. OffSml-Lab_SZVAV
18. OffSml-Office_SZVAV
19. OffSml-PSZ-Evap
20. OffSml-WSHP
21. RetlMed-PVAV-IndirDirEvap
22. RetlSml-DOAS+FPFC

Tip: Input Units
The input screens show the units for numerical inputs. For example, boiler efficiency is input as a
fraction like 0.8, not as a % like 80.
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Quick Start Guide Topics

Menu of Topics in this Quick Start Guide
Updates
Starting a New Project
Analysis Types
Compliance Types
Menu Bar
Tool Bar
Main Screen
Right Mouse Button Menu Options
Building Tree Controls (Parent/Child Relationships)
Input Dialog Windows
Status Bar
Defining New Components
Deleting Project Files
How to Report a Problem
License Agreement

Updates and New Project Website

We plan to issue updates to CBECC-Com often. You can check the new project website
(http://bees.archenergy.com/) where a link to the latest version will always be posted.

Starting a New Project

When CBECC-Com is first started, a dialog box will appear with the options (No. 2 option may not be
available on new CBECC-Com installations):

1. Open Recent Project

2. Select an Existing Project to Open

3. Create a New Simplified Geometry Project

Option 1 and Option 2 are essentially the same, except that the “Open Recent Project” option
automatically selects the project that was being worked on the last time CBECC-Com was open. The
“Select an Existing Project to Open” option simply requires browsing to the desired project.

If “Select an Existing Project to Open” is selected, the default file type in the browse window is a .cibd
file. However, this can be changed to .xml, allowing you to open an SDD XML file. This option should be
used when working on a Detailed Geometry project.

Users can take either approach (Detailed or Simplified – see User’s Manual for more information) to

modeling their project; however, the preferred workflow is to use the Detailed Geometry approach

using OpenStudio to create building model geometry using SketchUp with the OpenStudio plug-in.

OpenStudio includes an option for exporting an SDD file, which CBECC-Com can then open. The

http://bees.archenergy.com/
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Simplified Geometry approach is recommended for simpler buildings since this approach comes with

certain limitations that could prevent the project from getting credit for certain efficiency measures

included in the design.

For more information on the recommended workflow, please view the tutorials at
http://bees.archenergy.com/faq.html.

Return to Quick Start Main Menu

Analysis Types

Title24ProposedOnly: This will simulate the building input by the user with the 2013 compliance rules.

Title24Compliance: In addition to simulating the Proposed Design, this will simulate the Standard Design
building which complies with the 2013 Prescriptive Standards and establishes the energy budget for
compliance.

Return to Quick Start Main Menu

Compliance Types

NewComplete: Compliance of an all new, completely specified building. The building design includes
the building envelope, lighting systems and HVAC systems. The proposed simulation model is based on
user input, while the baseline simulation model will include envelope, lighting and HVAC systems that
are generated by the software based on the ACM rules.

NewEnvelope: Partial compliance of an all new building with only the envelope design completed. This
form of compliance might be used for a speculative office building where design of the lighting and
HVAC systems is waiting for tenant input. In this type of compliance, the proposed and baseline
simulation models will include lighting and HVAC systems that are generated by the software based on
the ACM rules.

NewEnvelopeAndLighting: Partial compliance of an all new building with the envelope and lighting
design completed. This form of compliance might be used for a speculative office building where design
of the HVAC systems is waiting for tenant input. In this type of compliance, the proposed and baseline
simulation models will include HVAC systems that are generated by the software based on the ACM
rules.

NewEnvelopeAndPartialLighting: Partial compliance of an all new building with the envelope and part
of the lighting design completed. This form of compliance might be used for a speculative office building
where design of the lighting systems in tenant spaces and all of the HVAC systems are waiting for tenant
input. In this type of compliance, the proposed and baseline simulation models will include HVAC
systems that are generated by the software based on the ACM rules. The baseline simulation model will
have all lighting generated by the rules, and the proposed model will include lighting systems generated
by the rules for those areas where a lighting design has not been specified by the user.

NewMechanical: Partial compliance of an all new building where the envelope and lighting design has
been previously approved and approval is now being sought for the HVAC system. In this type of
compliance, the proposed and baseline simulation models will both include envelope and lighting based

http://bees.archenergy.com/faq.html
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on user input. The proposed model HVAC system will be based on user input but the baseline will be
generated by the software based on the ACM rules.

NewMechanicalAndLighting: An all new building where the envelope has been previously approved and
approval is now being sought for the lighting and HVAC systems. In this type of compliance, the
proposed and baseline simulation models will both include the envelope based on user input. The
proposed model lighting and HVAC systems will be based on user input but for the baseline these will be
generated by the software based on the ACM rules.

NewMechanicalAndPartialLighting: An all new building where the envelope and part of the lighting
system has been previously approved and approval is now being sought for the remainder of the lighting
and all of the HVAC systems. In this type of compliance, the proposed and baseline simulation models
will both include envelope and the previously approved lighting based on user input. The proposed
model will include the remaining lighting and all HVAC systems based on user input but for the baseline
these will be generated by the software based on the ACM rules.

ExistingAddition: This option is now being replaced by additional partial compliance options which are
similar to the new construction compliance options. These apply to additions only (new conditioned
areas and systems) added to the existing building.

o AdditionComplete
o AdditionEnvelope
o AdditionEnvelopeAndLighting
o AdditionEnvelopeAndPartialLighting
o AdditionEnvelopeAndMechanical
o AdditionMechanical
o AdditionMechanicalAndLighting
o AdditionMechanicalAndPartialLighting

ExistingAlteration: An existing building where envelope, lighting or HVAC systems are being altered or
replaced, with no increase in building floor area. The proposed simulation is based on user input. The
baseline simulation model will be based on user input for those portions marked as existing, while new
or altered components will be replaced with software generated components based on the ACM rules.
The simulation must include all altered portions of the building, as well as all existing, unaltered portions
of the building which are served by HVAC systems that also serve altered portions. The simulation
models may also include all or part of the remaining existing, unaltered portions of the building.

ExistingAdditionAndAlteration: An all new addition to an existing building which is also being altered.
This is a combination of ExistingAddition plus ExistingAlteration, and the rules for those compliance
types apply.

Return to Quick Start Main Menu

Menu Bar

This section explains the program features you access by selecting the options on the menu bar at the
top of the screen.
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File – The File menu contains the standard functions for file management, loading recently used files,
saving a newly created file, print a file and exiting the program.

Edit – In addition to the standard Windows™ Cut, Copy, and Paste commands, the Edit menu contains
several commands for editing building descriptions. They are:

• Edit Component

• Create Component

• Delete Component

These menus allow you to edit all building components, including components that are not displayed on
the tree control. Use this method to edit components like schedules and performance curves.

Ruleset –CBECC-Com 2013 is designed to support multiple rulesets that implement the requirements in
different codes. However, different codes can require different information, and therefore, compliance
projects and model inputs defined using one ruleset will likely need to be revised to work with other
rulesets. This function may or may not be enabled in this version of the software.

View – Enables you to toggle the display of the Tool Bar and the Status Bar on and off.

Tools – The Tools menu contains the following options of interest to end-users:

• Program and Analysis Options – Allows users to set the various options related to storage of
simulation output and analysis files. Also allows users to set the proxy server settings to enable
access to the online report generator if the computer is behind a firewall

• View T-24 Compliance Report – Allows users to open an approved CBECC-Com2013 compliance
report in the local PDF document viewing software; typically Acrobat Reader. If no valid report
or results file is found it will prompt the user to perform the compliance analysis before
generating and/or viewing the compliance report.

• View Project Folder - Allows easy access to users to open the folder where all the project files
are stored and/or generated on analysis.

• View Project Log File - Allows users to open the project log file in the local text editor software;
typically Notepad.

• Delete Project Log File - Allows users to delete the project log file generated for the project.
Typically the project log file gets appended with information on opening/saving and running the
project. So if the user wishes to start with a fresh project log file this option allows the user to
delete the old log file.

• Perform Analysis – Performs compliance input checks and simulations based on the current
building description.

• Review Analysis Results – Allows users to review the results of the last simulation analysis that
was performed for the project. Please note that if any changes to the project were made after
the analysis and the project was not simulated again, the displayed results would not be current.

• Generate Draft T-24 Compliance Report – Generates a watermarked compliance report (pdf) for
review/printing. This watermarked report cannot be used to submit for compliance.

Help – The Help menu contains the following options of interest to end-users:

• Quick Start Guide – Opens up the Quick Start Guide for the software in the local PDF document
viewing software.
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• User Manual - Opens up the User’s Manual for the software in the local PDF document viewing
software.

• Compliance Forms Checklist – Opens up the compliance forms checklist document for New
Construction and Alterations projects in the local PDF document viewing software.

• Compliance Forms – Provides access to the various 2013 Nonresidential compliance form
documents and opens the selected form(s) in the local PDF document viewing software.

Return to Quick Start Main Menu

Tool Bar

This section explains the program features you access by selecting the icons on the tool bar at the top of
the screen.

New File

This button closes the current file (if one is open) and opens a new file.

Open Existing File

This button closes the current file (if one is open) and launches the Open dialog to enable you to
select an existing file to open.

Save File

This button saves the file under its current name or, if you have not named the file, launches the
Save As dialog to enable you to provide a new file name.

Cut Selected Item

This button is not currently enabled in CBECC-Com 2013.

Copy Selected Item

This button enables you to copy the selected item on the tree control (along with any child
components) to the Windows clipboard. The Copy button is not available from within program dialogs,
but you can use the keyboard equivalent, Ctrl+C, to copy selected text.

Paste Contents of Clipboard

This button enables you to paste components copied from the tree control to the selected location
in the tree control (provided that location is compatible with the stored component). The Paste button
is not available from within program dialogs, but you can use the keyboard equivalent, Ctrl+V, to paste
text from the Windows clipboard to the selected input field.

Print

This function is not available in CBECC-Com 2013.



Quick Start Guide Version CBECC-Com 2013-v3e – September, 2016

11

Building Creation Wizard

This function is not available in CBECC-Com 2013.

Perform Analysis

This button enables you to launch a compliance analysis using the currently loaded building
description. The behavior of this button identical to the Tools menu option. You must save the current
building description before performing the analysis.

Compliance Reports

This icon opens an approved CBECC-Com2013 Report in your local document viewing software;
typically Acrobat Reader. The behavior of this button identical to the Tools menu option - “View
Compliance Report”. You cannot open an approved report unless an analysis has been performed and
the model has not been modified since the analysis has been performed. This button may or may not be
enabled in this version of the software.

About CBECC-Com 2013

This button enables you to view program license and version information.

Print Preview

This function is not available in CBECC-Com 2013 and will be removed in future versions.

Help

Not yet implemented. For help with the program, please refer to this Quick Start Guide.

Return to Quick Start Main Menu

Main Screen

The main screen of the CBECC-Com 2013 program is used primarily for editing building descriptions.
There are two folder tabs at the top of the main screen—Envelope and Mechanical. These tabs provide
different views of the building description and provide access to two different subsets of the building
description data.

Return to Quick Start Main Menu

Right Mouse Button Menu Options

The CBECC-Com 2013 program makes extensive use of menu accessible by clicking the right mouse
button. The functions available through these menus depend on whether you are on the main screen or
in an input dialog window.

Main Screen Right Mouse Menu. When clicked over a building component, the following choices are
available:
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 Edit – Opens the input dialog window for the selected component
 Rename – Enables you to rename the selected component
 Delete – Deletes the selected component
 Copy – Copies the selected component with all of its child components
 Paste – Adds copied components and their children to the selected component
 Move Up in list, Move Down in list – Moves the component up or down in the list of components

that share a common parent. The input file is reordered accordingly. HVAC components are
reordered and will be simulated with components in the displayed order, except for fans which
are ordered based on the Fan Position parameter. For example, an evaporative cooler placed
before or after a cooling coil will have different effects in the simulation.

 View Space Footprint – Displays in your browser a diagram of the space (available for space
components only)

 Expand/contract – Expands or contracts the list of children components attached to a selected
component

 Create – Enables you to create new child components for the selected component

Input Dialog Right Mouse Menu. When clicked over an input value in the window, the following choices
are available:

 Item Help – Not yet implemented. Accesses Help information applicable to the selected input
field.

 Topic Help – Not yet implemented. Accesses Help information applicable to the selected
component.

 Restore Default – Returns the value of the field to its default value (if applicable)
 Critical Default Comment –Not yet implemented. Opens a dialog enabling you to enter a

justification for overriding values designated by the Code as critical defaults, i.e., a value that
should only be overridden with special justification.

Return to Quick Start Main Menu

Building Tree Controls (Parent/Child Relationships)

In order to analyze a building's energy use, it is necessary to track relationships among building
components. CBECC-Com 2013 displays these relationships using the familiar tree control, found in
Windows™ Explorer and many other applications. For example, under the Envelope tab, exterior walls
are shown as parents to windows (windows are connected to exterior walls and appear underneath
walls) and children to spaces. The tree controls vary in the components they display and depend on
which folder tab is currently selected.

Use the Tree Control for Rapid Editing

The tree control can be used to move and copy components or groups of components. To move a
component, just drag and drop. If an association isn’t allowed, the program will prevent the move from
being carried out. To copy a component, select the component, copy, and paste. It is advisable to
rename copied components to maintain readability. Whenever parents are moved, copied, or deleted,
all related child components are also moved, copied, or deleted.

Components shown on the tree can be moved using a drag-and-drop technique to other components
provided it results in a compatible parent-child relationship. For example, you can drag a window onto a
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different wall, but not vice versa. Re-ordering of child objects assigned to the same parent is currently
not supported.

A set of right mouse menu edit commands can be used with the tree control. These are described in the
Right Mouse Button Menu Options section. Double-clicking on any component on the tree opens its
input dialog window.

Return to Quick Start Main Menu

Input Dialog Windows

The attributes of each building component can be edited by opening the input dialog window for the
component. The dialog can be opened by double-clicking on the component on the tree control, using
the Edit option on the right mouse menu, or using the Edit Component option on the Edit menu. (The
tree control does not appear until you have created a project description using the wizard or loaded an
existing project file [Ctrl+O]).

In keeping with good practice for use of any software, we recommend that you save your building
description often and revise the file name once you have substantial effort invested in editing the
description under the current file name.

Background Colors

The following background color convention has been used in displaying data on the dialogs:

 White background = available for user input
 Gray background = not user editable

Text Colors

The following text color convention has been used in displaying data on the dialogs:

 Dark blue or cyan text = default values as defined by the current ruleset
 Red text = values that have been changed from their default values

For information on editing features available from the input dialog windows, see the Right Mouse
Button Menu Options section.

To understand what information you are required to enter, see the Status Bar section.

Return to Quick Start Main Menu

Status Bar

The second and third panes of the program status bar now report detailed version IDs of (1) the
software and (2) the ruleset that is referenced by the project currently loaded into the program:
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Note: The following features of the Status Bar have not been implemented in this version of CBECC-
Com.

The status bar at the bottom of the screen provides useful information about each input field you select.
There are three panes on the status bar that provide context-sensitive information. This same
information is displayed in the ToolTips if you allow your mouse pointer to linger over an input field.

1. Input Description Pane – Concise descriptions of the selected input field are displayed at the
far left of the status bar.

2. Input Classification Pane – The next pane to the right on the status bar displays a set of
labels that indicates which inputs you are required to provide, which are optional, and
which are unavailable for input. The input classification labels are explained in the table
below.

3. Data Source Pane – The pane at the far right of the status bar displays a set of labels that
identify the source of the information (if any) contained in the field. This can help you
distinguish between information that is dictated by the compliance checking process and
the information you have entered and for which you are responsible. The data source labels
are explained below.

Input Classification Explanations

No field selected No building data field is currently selected.

Input is compulsory You are required to enter data in the selected field; the program
cannot perform a compliance analysis unless you do.

Input is required You are required to enter data in the selected field if the field is
applicable to your project.

Input is optional You may enter data in the selected field if the field is applicable to
your project, but you are not required to do so. If the field
contains a default value, you are permitted to simply use that
value without considering its suitability for your project.

Input is critical default You may overwrite the data in the selected field with an entry
more appropriate for your project than the default. However, if
you do overwrite this "critical default" value, you must be
prepared to provide documentation substantiating the value you
have chosen.

Field is not editable You cannot enter data in the selected field. The data in this field
are defined by the compliance rule set or a supporting process. In
some cases, the field may also be an intermediate calculated
parameter or one that is not applicable to the currently selected
compliance rule set.

Navigation input The purpose of the selected field is to enable you to select a
component for editing without having to exit the current
component and choose the next component from the tree
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Data Source Explanations

No field selected No building data field is currently selected.

Value from user The data shown have been defined by the user either directly
through a user input or indirectly through wizard selections.

Value from simulation The data shown have been defined by an energy simulation.

Value undefined No data have yet been defined for the field.

Value from program The data in this field have been defined by the program either to
implement requirements and procedures specified in the energy
code or to conform to building energy modeling conventions.

Return to Quick Start Main Menu

Defining New Components

There are two main ways to define new components (e.g., walls or equipment) in the main program
interface.

Define a New Physical Component

To define a new physical component, follow these steps from the Main Program Screen:

 Right-click on the component on the tree control to which you want to add the new component.
 Select Create, then the type of object you want to add. (Only applicable component types will

appear on the list.)
 Accept the default name, parent, and existing component to copy from or edit these fields and

click OK.
 Edit the input fields with white backgrounds to describe the new component and click OK.

Return to Quick Start Main Menu

Deleting Project Files

If you have created multiple projects under different project names, you may want to delete project files
to free up hard disk space on your computer. By default, project files are stored in the C:\Users\<your
username>\My Documents\ CBECC-Com 2013 Projects\ directory, although where the files are stored
may differ on your computer depending upon where you installed the program and if you selected a
different location for storing files.

In the Projects folder, you will find several files with the same project name you used but with differing
file extensions. If you have no further use for information on a project, delete all files using the primary
file name. If you would like to retain a project but store it as efficiently as possible, delete all files using
the primary file name EXCEPT the one having a .cibd (input building design) file name extension. The
other project files are recreated when an analysis is performed, with the exception of the project .log
file. The log file lists compliance analysis warnings and errors shown in the UI, as well as other
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information related to processing/simulating models. Each time analysis is performed; new messages
are appended to the end of this file, and should be reviewed when troubleshooting your compliance
analysis.

Return to Quick Start Main Menu

How to Report a Problem

This software is released for testing purposes and we anticipate the user running into errors and
problems. We appreciate your willingness to help us make progress by taking the extra time to
document and report issues in a way that will help us fix them quickly.

When you come across an issue, please log an issue at the CBECC-COM website at:
http://bees.archenergy.com/issue.html

If you experience any issues submitting an issue through the website, please send an email to:
CBECC-COM Support <cbecc.com@gmail.com>

And include as much of the following as possible (copy and paste this template into your email):

Type of Issue

CBECC-COM version (Version can be found in the Help-> About menu) and is represented as
show below: CBECC-COM 2013-3

Describe the error, using as much detail as possible.

List the steps taken to produce the error, using as much detail as possible.
1. Step 1
2. Step 2 etc.
If there is an error message, what is the message? If possible, take a screenshot of the error
message and attach it to the email as a file.

Please attach your <ProjectName>.cibd file. This is the file you open and save from inside
CBECC-Com. By default, this file is located in the following directory, C:\Users\<your
username>\My Documents\CBECC-Com 2013 Projects.

If you include your name and phone number, we may call you to clarify the problem or ask for more
details. We will not share your name, phone number or email address with anyone outside the CBECC-
Com development team or use it for any purpose other than responding to your report.

Return to Quick Start Main Menu

http://bees.archenergy.com/issue.html
mailto:cbecc.com@gmail.com
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License Agreement

Copyright (c) 2012-2016, California Energy Commission

Copyright (c) 2012-2016, Wrightsoft Corporation

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
the following disclaimer in the documentation and/or other materials provided with the
distribution.

• Neither the name of the California Energy Commission nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written
permission.

DISCLAIMER: THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT ARE DISCLAIMED. IN NO EVENT SHALL
CALIFORNIA ENERGY COMMISSION, WRIGHTSOFT CORPORATION, ITRON, INC. OR ANY
OTHER AUTHOR OR COPYRIGHT HOLDER OF THIS SOFTWARE (COLLECTIVELY, THE
"AUTHORS") BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. EACH LICENSEE AND SUBLICENSEE
OF THE SOFTWARE AGREES NOT TO ASSERT ANY CLAIM AGAINST ANY OF THE
AUTHORS RELATING TO THIS SOFTWARE, WHETHER DUE TO PERFORMANCE ISSUES,
TITLE OR INFRINGEMENT ISSUES, STRICT LIABILITY OR OTHERWISE.

Return to Quick Start Main Menu


